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SUMMARY:  14 
A protocol for imaging the dynamic microtubules in vivo using fluorescently labeled End 15 
binding protein has been presented. We described the methods to label, image, and 16 
analyze the dynamic microtubules in the Posterior lateral microtubule (PLM) neuron of C. 17 
elegans. 18 
 19 
ABSTRACT:  20 
In neurons, microtubule orientation has been a key assessor to identify axons that have 21 
plus-end out microtubules and dendrites that generally have mixed orientation. Here we 22 
describe methods to label, image, and analyze the microtubule dynamics and growth 23 
during the development and regeneration of touch neurons in C. elegans. Using 24 
genetically encoded fluorescent reporters of microtubule tips, we imaged the axonal 25 
microtubules. The local changes in microtubule behavior that initiates axon regeneration 26 
following axotomy can be quantified using this protocol. This assay is adaptable to other 27 
neurons and genetic backgrounds to investigate the regulation of microtubule dynamics 28 
in various cellular processes. 29 
 30 
INTRODUCTION:  31 
Neurons have an elaborate architecture with specialized compartments like dendrites, 32 
cell bodies, axons, and synapses. The neuronal cytoskeleton is constituted of the 33 
microtubules, microfilaments, and neurofilaments and their distinct organization supports 34 
the neuronal compartments structurally and functionally 1–10. Over the years, microtubule 35 
organization has been identified as a key determinant of neuronal polarity and function. 36 
As neurons undergo structural remodeling during development or regeneration, the 37 
microtubule dynamics and orientation determine the identity, polarized transport, growth, 38 
and development of various neuronal compartments 7. It is, therefore, imperative to 39 
assess the microtubule dynamics and orientation in vivo to correlate with the neuronal 40 
remodeling process.  41 
 42 
Microtubules are composed of protofilaments of α and β Tubulin heterodimers with 43 
dynamic plus ends and relatively stable minus ends 11, 12. The discovery of the plus tip 44 
complex and associated end binding proteins have enabled a platform to assess the 45 
microtubule organization 13. End binding proteins (EBP) transiently associate with the 46 
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growing plus ends of the microtubule and their association dynamics are correlated to the 47 
growth of the microtubule protofilaments 14, 15. Due to their frequent association and 48 
dissociation, the point spread function of GFP-tagged EBP appears as a “comet” in a 49 
timelapse movie 15. Since the pioneering observation in mammalian neurons 16, end 50 
binding proteins tagged with fluorescent proteins have been used to determine 51 
microtubule dynamics across different model systems and neuron types 17–23. 52 
 53 
Due to its simple nervous system and transparent body, C. elegans has proven to be an 54 
excellent model system to study neuronal remodeling during development and 55 
regeneration. Here we describe methods to label, image, and analyze the microtubule 56 
dynamics and growth during the development and regeneration of touch neurons in C. 57 
elegans. Using genetically encoded EBP-2::GFP, we imaged the microtubules in the PLM 58 
neuron, which allowed us to determine the polarity of the microtubules in two different 59 
neurites of this neuron 24. This method allows observation and quantification of the EBP 60 
comets as a measure of microtubule dynamics in different cellular contexts, for example, 61 
the local changes in microtubule behavior that initiates axon regeneration following 62 
axotomy can be assessed using our protocol. This assay is adaptable to other neurons 63 
and genetic backgrounds to investigate the regulation of microtubule dynamics in various 64 
cellular processes. 65 
 66 
PROTOCOL: 67 
 68 
1. Reporter strain: Culture and maintenance 69 
 70 
NOTE: To measure the microtubule dynamics and orientation in the PLM neurons, we 71 
used the worm strain expressing EBP-2::GFP under the touch neuron specific promoter 72 
mec-4 (juIs338 allele)25–27. We use standard worm culture and maintenance methods for 73 
this strain 28. 74 
 75 
1.1. Prepare the Nematode Growth Medium (3.0 g/L sodium chloride, 2.5 g/L 76 
peptone, 20.0 g/L agar, 10 mg/L cholesterol (diluted from a stock solution of 10 mg/mL)) 77 
in water and autoclave the mixture.  78 
 79 
1.2. Cool the mixture briefly for 10-15 min before supplementing it with 1 mM calcium 80 
chloride, 1 mM magnesium sulfate and 25.0 mM potassium phosphate monobasic pH 81 
6.0.  82 
 83 
1.3. Pour around 9 mL of the mixture into 60 mm Petri dishes using a sterile 84 
dispenser followed by storage at room temperature and sterile conditions for a day and 85 
subsequent storage at 4 °C. 86 
 87 
1.4. Prepare 50 mL of B Broth (5.0 g/L sodium chloride, 10.0 g/L Bacto-Tryptone), 88 
autoclave and cool it down before inoculating with a single colony of Escherichia coli 89 
(OP50 strain).  90 
 91 



   

1.5. Culture the bacteria at 37 °C for 12 hours. Bring the refrigerated NGM plates to 92 
room temperature for seeding and using a sterilized glass spreader make a smear of 93 
OP50 bacteria onto the NGM plate. 94 
 95 
1.6. Keep the inoculated NGM plates at 37 °C for 12 hours, which will allow the 96 
formation of a bacterial lawn for the culturing of C. elegans. These plates can be stored 97 
in a 20 °C incubator until usage. 98 
 99 
1.7. Rear the transgenic strain on the seeded NGM plates.  100 
 101 
1.8. Sterilize a platinum wire pick on flame and pick 20-25 gravid adult 102 
hermaphrodites for transfer to a freshly seeded plate. 103 
 104 
1.9. Once transferred, shift the plate to a 20 °C incubator for 1 h. Then, extract the 105 
adults from these plates. These plates will now contain eggs that are age-matched. 106 
 107 
1.10. Shift the plates to the 20 °C incubator for rearing until they reach the 108 
developmental stage of interest which in this case is the L4 stage at 43.5 hours after 109 
egg-laying. For more worms, rear multiple plates to avoid crowding.  110 
 111 
1.11. At the desired developmental stage, these worms can be mounted for imaging of 112 
the EBP-2::GFP comets. 113 
 114 
2. Sample preparation: Mounting of worms for imaging of EBP-2 comets 115 
 116 
NOTE: To enable live observation of the EBP comets in the PLM neurons, we mounted 117 
the worms on agarose pads to minimize their mobility while not compromising the 118 
physiology of the neuron. Among the various immobilization methods, we have chosen 119 
0.1 µm Polystyrene bead solution readily available commercially. We have outlined the 120 
mounting procedure used specifically for EBP-2::GFP observation. 121 
 122 
2.1. Prepare a solution of 10% agarose by melting 0.2 g of agarose in 2 mL of 1x M9 123 
buffer (0.02 M KH2PO4, 0.02 M Na2HPO4, 0.008 M NaCl, 0.02 M NH4Cl) in a 5 mL glass 124 
test tube over a flame. This test tube can easily fit into a heating block which keeps the 125 
agarose in the molten state until usage.  126 
 127 
2.2. Using a wide-mouthed dropper, dispense a drop (around 100 µL) of this molten 128 
agarose over a clean glass slide of 35 mm x 25 mm dimensions.  129 
 130 
2.3. While it is in the molten state, press the drop with another glass slide to create a 131 
thin film of the agarose between the glass slides. The agarose solidifies as a film of around 132 
0.5 – 1.0 mm in thickness in around 30 seconds.  133 
 134 
2.4. Once the agarose solidifies, hold the bottom slide in the non-dominant hand and 135 
the top slide in the dominant hand. Flip up the top slide while holding the bottom slide 136 
steady as a result of which the agarose pad sticks to one of the two slides. 137 



   

 138 
2.5. If the formed agarose pad is larger than the coverslip size (18 mm x 18 mm), then 139 
trim the edges of the pad to obtain the required dimensions to ensure proper placement 140 
of the coverslip. These agarose pads are for the immediate use and not to be stored.  141 
 142 
2.6. Visually inspect the agarose pad for a smooth surface which are moist and suitable 143 
for mounting. If the agarose pad is exposed to air and becomes dried, the surface of the 144 
agarose pad appears wrinkled. In such a scenario, prepare fresh agarose pad as 145 
mentioned in steps 2.2-2.6.  146 
 147 
2.7. On the agarose pad, put 2 µL of 0.1 µm polystyrene bead solution as the mounting 148 
medium. 149 
 150 
2.8. Pick 3-4 worms using a platinum wire pick and shift them onto an unseeded NGM 151 
plate. This process ensures the removal of surface bacteria that hinders the 152 
immobilization during mounting.  153 
 154 
2.9. Once the worms crawl out of their surface bacteria, pick them up for mounting 155 
using a platinum wire pick and resuspend them in the drop of polystyrene beads on the 156 
agarose pad. 157 
 158 
2.10. Carefully, place an 18 mm x 18 mm coverslip on the worms. To prevent 159 
evisceration of the mounted worms, do not move the coverslip after placement. 160 
 161 
2.11. Mount the prepared slide on the microscope for imaging. 162 
 163 
3. Imaging setup and acquisition 164 
 165 
NOTE: EBP comets travel with an approximate velocity of 0.22 µm/s as observed in the 166 
mammalian and PLM neurons of C. elegans 16, 18. To optimally sample the events in a 167 
time lapse acquisition as per Nyquist criteria 29, spatial and temporal scales of 0.09 µm 168 
and 0.43 s, respectively, are required. For the prevention of phototoxicity or 169 
photobleaching, we used Spinning Disk acquisition. We have described our imaging 170 
setup and acquisition settings below.  171 
 172 
3.1. Capture the images using an inverted microscope equipped with a spinning disk 173 
unit and camera. Turn on the setup as per the manufacturer’s instruction. 174 
 175 
3.2. Turn on the software that controls the setup. 176 
 177 
3.3. As this is an inverted microscope, place the slide with the mounted worms on the 178 
stage with a low magnification objective (5x or 10x) with the coverslip facing down. 179 
 180 
3.4. Set up the light path to eye or visible mode which uses illumination from halogen 181 
lamp for transmitted light and mercury arc lamp for reflected light.  182 
 183 



   

3.5. Focus and center a worm in the view field under the brightfield. 184 
 185 
3.6. Put the immersion oil and change the magnification to 63x (1.4NA/Oil) and refocus 186 
the worm tail in the brightfield for the PLM neurons.  187 
 188 
3.7. Turn on the fluorescence of the mercury arc lamp for a brief refocusing of the PLM 189 
neurons. Place the correct set of reflector (AF488) in the light path for the visualization of 190 
GFP. 191 
 192 
3.8. Set the microscope to the camera acquisition by directing the light path to the 193 
camera. 194 
 195 
NOTE: Controlling steps 3.4-3.7 through the Thin Film Transistor (TFT) screen of the 196 
microscope is quick and prevents unnecessary exposure to the illumination. Alternatively, 197 
control the illumination, reflector through the software. 198 
 199 
3.9. After the focusing of the PLM neuron in the view field, in the software interface 200 
select the illumination of 488 nm laser with 30% power and 300 ms exposure for the 201 
camera with Electron Multiplying (EM) gain value 70. Depending upon the reporter 202 
expression, vary these parameters as required. Store the settings as a configuration for 203 
subsequent imaging sessions. 204 
 205 
3.10. The Channels tab stores the tracks each with a specific illumination and camera 206 
setting. The highlighted track allows a live visualization whereas for acquiring an image 207 
the track needs to be ticked on. Highlight a channel with brightfield (DIC) for live 208 
visualization of the tail of the worm in the workspace. The sample is focused and centered 209 
in the live imaging window of the workspace. 210 
 211 
3.11. Highlight the channel with 488 nm laser excitation for a quick focusing of the PLM 212 
neuron in the live imaging window. Once focused, begin the time lapse acquisition by 213 
setting the time series parameters as mentioned in 3.12. 214 
 215 
3.12. Using 488 nm laser illumination, set up an experiment with time series for 2 216 
minutes and no time interval between frames. To maintain the temporal scales of image 217 
acquisition, we only acquired GFP fluorescence only.  218 
 219 
3.13. Using the Start Experiment tab, begin the acquisition. Using a 63x magnification 220 
restricts the spatial resolution to 0.21 µm which is sampled by the camera at the pixel size 221 
of 0.09 µm. Acquire a time lapse at 3.3 frames/s for optimally sample the event. The time 222 
lapse image had 396 time frames acquired over a duration of 2 min. Following the 223 
acquisition, save the image in ‘.czi’ format, which can be later be accessed by ZEN 2 or 224 
ImageJ. 225 
 226 
4. Observation and analysis 227 
 228 



   

4.1. Preview the timelapse acquisition in the software or open it in Image J through its 229 
Bioformats plug-in.  230 
 231 
NOTE: We have described the process of image analysis in Image J. 232 
 233 
4.2. Install the Bioformats plug-in in ImageJ. 234 
 235 
4.2.1. Alternatively, export the “.czi” format file into .tif for file compatibility in ImageJ. 236 
Export function in ZEN2 results in individual frames of the image as discrete .tif files. We 237 
avoid this method to prevent the formation of a large number of files. 238 
 239 
4.3. Open the image in ‘.czi’ format directly in Image J through its ‘Bioformats’ plugin. 240 
The image opens as a multi-image stack. If using the “export’ function of ZEN2, then 241 
reconstitute the images as a multi-image stack using the following workflow in ImageJ: 242 
ImageJ Program > Image Menu > Stacks Submenu > Images To Stack.  243 
 244 
4.4. Preview the image as a movie using the Play icon at the left bottom corner of the 245 
image window. The comets can be seen as bright mobile punctae in the cell body and 246 
processes of the PLM neuron. If the comets are visible clearly, proceed to step 4.8 247 
otherwise follow steps 4.5-4.7.  248 
 249 
4.5. Convert the color profile of the image using the Lookup Table (LUT) to a grayscale 250 
image: ImageJ program > Image menu > Lookup Tables submenu > Select Grays. 251 
 252 
4.6. Invert the LUT profile of the image for easy visualization:  ImageJ program > 253 
Image menu > Lookup Tables submenu > Invert. 254 
 255 
4.7. Adjust the brightness and the contrast of the image for seeing the comets: ImageJ 256 
program > Image menu > Adjust submenu > Brightness and Contrast.  257 
 258 
4.7.1. Move the sliders of Minimum, Maximum, Brightness, and Contrast for the 259 
desired scaling of the intensities across the image. We quantified the images with comets 260 
visible distinctly. 261 
 262 
4.8. The basic version of ImageJ has startup tools represented as icons. Locate and 263 
right-click the icon with a line to open a dropdown menu and select the Segmented line. 264 
Draw the segmented line on the regions of interest (ROI) with its origin on or near the cell 265 
body of the neuron.  266 
 267 
4.8.1. For later considerations, save the segmented line ROI through the ROI manager 268 
using the following workflow: ImageJ > Analyze > Tools > ROI manager > Select the 269 
drawn trace in the image and click Add in the ROI manager window > More in the ROI 270 
manager window > Save. 271 
 272 
4.9. Before generating the kymograph, as the spatial and temporal scales are different 273 
remove the scaling to obtain the measurements in pixels using the following: 274 



   

ImageJ > Analyze > Set scale > Click to remove scale > Ok.  275 
 276 
4.10. Using the Reslice function under the Image > Stacks dropdown menu, generate 277 
a kymograph. The kymograph is a representation of the segmented ROI in time. The 278 
horizontal axis represents the distance and the vertical axis represents the time. The 279 
diagonal traces represent the moving comets. Generally, the kymograph takes the color 280 
profile of the image otherwise assign a color profile as described in steps 4.5-4.6 for the 281 
visualization of the diagonal traces.  282 
 283 
4.11. Using the Straight line function in the drop-down menu of the Line tool (refer to 284 
step 4.9) draw straight lines over each of the diagonal traces and append them in the ROI 285 
manager. 286 
 287 
4.12. Under the Analyze tab, go to Set Measurements and select Mean Intensity and 288 
Bounding Rectangle parameters for measuring the traces. 289 
 290 
4.13. In the ROI manager window, click Measure which will open a Result window which 291 
will yield the mean intensity of ROI, the X and Y coordinates of the line traces, Width, 292 
Height, Angle, and Length of the line traces. This window can be saved as a .csv format 293 
and later imported into a data analysis program. 294 
 295 
4.14. In the spreadsheet program, the results window opens with the values distributed 296 
in rows and columns. The relevant values are the width, height, and angle of the traces. 297 
The width gives the displacement of the trace, height gives the duration and the angle 298 
represents the vector. As the width and height values are in pixels, multiply them with the 299 
spatial and temporal scales, respectively, for obtaining the standard measurable 300 
parameters. 301 
 302 
4.15. As the left side of the kymograph is proximal to the cell body, depending on the 303 
angle, classify comets into plus-end-out or minus-end-out (i.e., away from the cell body 304 
or towards the cell body, respectively). Classify angles between 1° to -89° and -91° to -305 
179° will be classified as plus-end-out and minus-end-out, respectively. Collate data from 306 
multiple kymographs in a spreadsheet for a study and statistically represent. 307 
 308 
REPRESENTATIVE RESULTS: 309 
As a representative example, we have described in vivo observation of the EBP comets 310 
in the steady-state and regenerating axons of the PLM neurons. PLM neurons are located 311 
in the tail region of the worm with a long anterior process that forms a synapse and a 312 
short posterior process. PLM neurons grow in the anterior-posterior direction close to the 313 
epidermis and are responsible for the gentle touch sensation in the worms. Due to their 314 
simplified structure, and amenability to imaging and microsurgery, PLM neurons have 315 
been extensively investigated for their microtubule cytoskeleton 30, axonal transport 31, 32, 316 
and regeneration 33, 34, neuronal polarity 35–37, behavior and aging 38, 39 and many other 317 
neuronal processes. We used PLM neurons to assess microtubule dynamics and 318 
orientation in vivo in a transgenic expressing EBP-2::GFP under the mec-4 promoter. 319 
 320 



   

For checking the steady-state dynamics of the microtubules, we picked the worms 321 
expressing the Pmec-4-EBP-2::GFP reporter. The worms were mounted in 0.1 µm 322 
polystyrene beads on 10% agarose pads. The coverslip was added gently, and the worms 323 
were imaged on the spinning disk microscope. The PLM neurons were centered and 324 
focused on 63x and imaged with a frame rate of 3.3 frames per second. The anterior 325 
process of the PLM showed a majority of the comets moving away from the cell body 326 
whereas the posterior process showed a bidirectional movement of the comets (Figure 327 
1). Based on the direction of the comets, the anterior process of the PLM contains unipolar 328 
plus-end-out microtubules while the posterior process has mixed polarity (plus and minus-329 
end-out) of microtubules (Figure 2) 24. 330 
 331 
As an application of the assay, we explored the microtubule dynamics and orientation in 332 
the regenerating axons of PLM neurons. Previous studies have established methods of 333 
laser mediate axotomy using various types of lasers including, UV, nanosecond, 334 
picosecond, and femtosecond lasers 32, 40–46. For this study, we used a femtosecond laser 335 
to sever the anterior process of the PLM neurons 46. Following the injury, the worms were 336 
recovered onto seeded NGM plates. The worms were then imaged at multiple time points 337 
after injury for the observation of EBP-2::GFP comets. At 2 h after injury, a severed axon 338 
was visible however, the comets were drastically reduced in number as compared to an 339 
uninjured axon. At 11 h after injury, the axons have elicited a regeneration response in 340 
the form of axonal regrowth where a large number of EBP-2::GFP comets were observed 341 
(Figure 3). 342 
 343 
FIGURE AND TABLE LEGENDS: 344 
Figure 1: Observation and analysis of EBP comets. 345 
(A) Schematic of the PLM neuron showing its position with respect to the worm 346 
anatomy.  347 
(B) The point of reference is selected as per the neuron type. In this case, the cell 348 
body of the PLM neuron serves as the reference point for the regions of interest in anterior 349 
or posterior processes. Comets (magenta circles) are visible as punctae in the cell body, 350 
anterior and posterior processes of the PLM neuron. A segmented line tracing the neurite 351 
of interest (anterior process) is drawn to extract a kymograph. 352 
(C) A typical ROI can be converted into a kymograph which is a distance-time image 353 
with diagonal traces representing the moving comets. With respect to the cell body, the 354 
plus-end-out comets are traced in cyan whereas minus-end-out comets are traced in pink. 355 
For spatial reference, the segmented ROI is represented on top of the raw kymograph. 356 
(D) Measurement parameters include the width, height, angle, and length of the trace 357 
that can be translated into microtubule parameters. 358 
(E) Analysis parameters are extracted from the measurement parameters of width, 359 
height, and angle of the traces.  360 
 361 
Figure 2: Steady-state dynamics of the microtubules in the PLM axon. 362 
(A) Snapshots of a representative time series of EBP-2::GFP comets in the PLM 363 
neurons showing some of the EBP-2::GFP comets (colored arrows) in the anterior and 364 
posterior processes of the PLM neuron 365 



   

(B) Two regions in the anterior process (ROI-A, and ROI-B) are converted to 366 
kymographs in which the traces corresponding to the comets marked in 2(A). The traces 367 
have been color and number coded with respect to the moving comets in 2(A). Lower 368 
graphic panel represents the observed traces distinguished based on their direction of 369 
the movement. Plus end out comets are marked in cyan whereas minus end out comets 370 
are marked in pink. For reference, location of the cell body is depicted at the bottom. 371 
(C) ROI-C in the posterior process is converted into the kymographs with traces 372 
corresponding to the moving comets in posterior process in the Figure 2(A). Rightmost 373 
panel represents the plus end and minus end out traces with respect to the position of the 374 
cell body marked at the bottom. 375 
Notice that all the traces in the axonal regions (ROI-A, and ROI-B) are moving away from 376 
the cell body representing plus-end-out microtubules (cyan traces). On the contrary, in 377 
the posterior process (ROI-C), the traces are bidirectional representing the mixed polarity 378 
with plus (cyan traces) and minus-end-out (pink traces) microtubules. 379 
 380 
Figure 3: Microtubules during axonal regeneration in PLM neurons. 381 
(A) Schematic representation of the axotomy procedure using a femtosecond laser. The 382 
laser creates an injury followed by the initiation of the regrowth. Major regeneration 383 
responses are scored as Type 1 fusion, Type 2 fusion, and Regrowing axons.  384 
(B) Representative images of PLM neurons expressing EBP-2::GFP in the uninjured (0 385 
h), axotomized (2 h post axotomy), and regrowth conditions (11 h post axotomy). The 386 
ROI traced for the kymographs have been marked on the images. 387 
(C) Representative kymographs of axonal regions traced on the uninjured, injured, 388 
regrowing, and Type 1 fusedaxons. Notice that the number of EBP-2::GFP comets 389 
significantly decreased in the injured axons followed by their robust movement (increased 390 
growth length and duration) in the regrowing axon. Individual traces can be quantified and 391 
classified as per their direction (cyan and pink traces). 392 
 393 
DISCUSSION:  394 
Understanding the microtubule dynamics has been a key focus in the field of cytoskeletal 395 
research over the years. Microtubules undergo nucleation and catastrophe along with a 396 
continuous process of dynamic instability 47–50. Much of this information has been 397 
obtained through in vitro assays like light scattering readouts of free vs polymerized 398 
tubulin, microtubule growth assays from fluorescent tubulin, etc. 51. While the live 399 
observation of fluorescent and non-fluorescent microtubules is feasible in thin cells, in 400 
vivo measurements of microtubule dynamics are challenging. 401 
 402 
Using this transgenic strain, other touch neurons like PVM, ALM, and AVM can also be 403 
assessed for the microtubule orientation. The imaging, and analysis procedures 404 
described here can be adapted to other neuron types in C. elegans with an appropriate 405 
reporter transgenic however, the variability in the comet dynamics across different 406 
neurons is expected 52–55. This method is also applicable to non-neuronal cell types in C. 407 
elegans 56–59. In non-neuronal cell types like epidermis or embryo, the microtubule 408 
dynamics are observed in two dimensions 56–59. For such events, images of the time 409 
series are projected into a single image using Z-projection or Stack difference images to 410 
extract the ROI for the kymographs.  411 



   

 412 
We observed that the commercially available anesthetics like Levamisole hydrochloride, 413 
Tetramisole are not suitable for immobilization of the worms as they attenuate the comet 414 
dynamics drastically. Microbeads on 10% agarose pads are a suitable choice for 415 
immobilization during imaging 60, 61. However, longer exposure to a higher percentage of 416 
agarose and microbeads may lead to physical stress to the worms. Also, it is advisable 417 
to bring the microbead solution to room temperature before mounting as cold shock may 418 
lead to a change in the microtubule dynamics 62–66. Moisture in the agarose pads is a 419 
sensitive factor for immobilization, as worms may get desiccated in dryer agarose pads 420 
and moist agarose pads may not restrict worms’ mobility. The experimenter can visually 421 
inspect the agarose pad for smooth and leveled surface before mounting 67. The mounting 422 
procedure can further be improved by reducing the bacteria associated with the worms. 423 
The surface adherent bacteria hinder the immobilization of the worm whereas the gut 424 
bacteria result in autofluorescence that may occlude the signal of EBP-2::GFP comets. 425 
So it is preferable to grow the worms on freshly seeded OP50 plates and remove the 426 
surface bacteria by putting the worms on unseeded NGM plates or washing them with M9 427 
buffer or floatation in sucrose solution 68, 69.  428 
 429 
Among the observation parameters, the spatial and temporal scales are critical to 430 
optimally sample the comets 29. EBP-2::GFP is sensitive towards photobleaching thus 431 
unnecessary exposure to light should be prevented. Live imaging with fluorescent probes 432 
also causes phototoxic damage due to the production of free radicals. This might hamper 433 
the microtubule dynamics and may be fatal to the worm. A low exposure acquisition setup 434 
can be used to circumvent the problems of photobleaching and phototoxicity. The 435 
analysis parameters will be valid for multidimensional comet movements as well, 436 
however, one needs to determine the point of reference correctly.  437 
 438 
Each of the modules described in this study can be adapted to other reporters that detect 439 
the minus ends of microtubules, a vesicular organelle within axon or dendrites, etc. This 440 
technique can also be applied to other organisms or tissues with appropriate transgenesis 441 
and imaging system. The information of microtubule dynamics is valid in other cellular 442 
processes like cell division, cell migration, maintenance of cellular architecture, and other 443 
microtubule-based processes. Various clinical conditions have been associated with 444 
microtubule organization and dynamics 7, accurate information of which may strengthen 445 
pharmacological approaches. 446 
 447 
ACKNOWLEDGMENTS:  448 
We thank Yishi Jin and Andrew Chisholm for the initial support and the strain used in the 449 
study. The bacterial strain OP50 was commercially availed from Caenorhabditis Genetics 450 
Center (CGC) funded by NIH Office of Research Infrastructure Programs (P40 451 
OD010440). We also thank Dharmendra Puri for the standardization of the experimental 452 
procedures. The study is funded by the core grant of National Brain Research Centre 453 
(supported by Department of Biotechnology, Govt. of India), DBT/Wellcome Trust India 454 
Alliance Early Career Grant (Grant # IA/E/18/1/504331) to S.D., Wellcome Trust-DBT 455 
India Alliance Intermediate Grant (Grant # IA/I/13/1/500874) to A.G.-R and a grant from 456 
Science and Engineering Research Board (SERB: CRG/2019/002194) to A.G.-R. 457 



   

 458 
DISCLOSURES:  459 
The authors declare no conflicts of interest. 460 
 461 
REFERENCES:  462 
1. Bush, M.S., Eagles, P.A.M., Gordon-Weeks, P.R. The neuronal cytoskeleton. 463 
Cytoskeleton: A Multi-Volume Treatise. 3 (C), 185–227, doi: 10.1016/S1874-464 
6020(96)80009-7 (1996). 465 
2. Kapitein, L.C., Hoogenraad, C.C. Building the Neuronal Microtubule Cytoskeleton. 466 
Neuron. 87 (3), 492–506, doi: 10.1016/j.neuron.2015.05.046 (2015). 467 
3. Tas, R.P., Kapitein, L.C. Exploring cytoskeletal diversity in neurons. Science. 361 468 
(6399), 231–232, doi: 10.1126/science.aat5992 (2018). 469 
4. Kirkpatrick, L.L., Brady, S.T. Molecular Components of the Neuronal Cytoskeleton. 470 
Basic Neurochemistry: Molecular, Cellular and Medical Aspects. 6th edition. at 471 
<https://www.ncbi.nlm.nih.gov/books/NBK28122/> (1999). 472 
5. Muñoz-Lasso, D.C., Romá-Mateo, C., Pallardó, F. V., Gonzalez-Cabo, P. Much 473 
More Than a Scaffold: Cytoskeletal Proteins in Neurological Disorders. Cells. 9 (2), 358, 474 
doi: 10.3390/cells9020358 (2020). 475 
6. Menon, S., Gupton, S.L. Building Blocks of Functioning Brain: Cytoskeletal 476 
Dynamics in Neuronal Development. International Review of Cell and Molecular Biology. 477 
322, 183–245, doi: 10.1016/bs.ircmb.2015.10.002 (2016). 478 
7. Lasser, M., Tiber, J., Lowery, L.A. The role of the microtubule cytoskeleton in 479 
neurodevelopmental disorders. Frontiers in Cellular Neuroscience. 12, 165, doi: 480 
10.3389/fncel.2018.00165 (2018). 481 
8. Konietzny, A., Bär, J., Mikhaylova, M. Dendritic Actin Cytoskeleton: Structure, 482 
Functions, and Regulations. Frontiers in Cellular Neuroscience. 11, 147, doi: 483 
10.3389/fncel.2017.00147 (2017). 484 
9. Helfand, B.T., Mendez, M.G., Pugh, J., Delsert, C., Goldman, R.D. A Role for 485 
Intermediate Filaments in Determining and Maintaining the Shape of Nerve Cells. 486 
Molecular Biology of the Cell. 14 (12), 5069–5081, doi: 10.1091/mbc.E03-06-0376 (2003). 487 
10. Lariviere, R.C., Julien, J.P. Functions of Intermediate Filaments in Neuronal 488 
Development and Disease. Journal of Neurobiology. 58 (1), 131–148, doi: 489 
10.1002/neu.10270 (2004). 490 
11. Desai, A., Mitchison, T.J. Microtubule polymerization dynamics. Annual Review of 491 
Cell and Developmental Biology. 13, 83–117, doi: 10.1146/annurev.cellbio.13.1.83 492 
(1997). 493 
12. Nogales, E., Wolf, S.G., Downing, K.H. Structure of the αβ tubulin dimer by 494 
electron crystallography. Nature. 391 (6663), 199–203, doi: 10.1038/34465 (1998). 495 
13. Akhmanova, A., Steinmetz, M.O. Microtubule +TIPs at a glance. Journal of Cell 496 
Science. 123 (20), 3415–3419, doi: 10.1242/jcs.062414 (2010). 497 
14. Bieling, P. et al. Reconstitution of a microtubule plus-end tracking system in vitro. 498 
Nature. 450 (7172), 1100–1105, doi: 10.1038/nature06386 (2007). 499 
15. Perez, F., Diamantopoulos, G.S., Stalder, R., Kreis, T.E. CLIP-170 highlights 500 
growing microtubule ends in vivo. Cell. 96 (4), 517–527, doi: 10.1016/S0092-501 
8674(00)80656-X (1999). 502 
16. Stepanova, T. et al. Visualization of microtubule growth in cultured neurons via the 503 



   

use of EB3-GFP (end-binding protein 3-green fluorescent protein). Journal of 504 
Neuroscience. 23 (7), 2655–2664, doi: 10.1523/jneurosci.23-07-02655.2003 (2003). 505 
17. Rolls, M.M., Satoh, D., Clyne, P.J., Henner, A.L., Uemura, T., Doe, C.Q. Polarity 506 
and intracellular compartmentalization of Drosophila neurons. Neural Development. 2 (1), 507 
7, doi: 10.1186/1749-8104-2-7 (2007). 508 
18. Ghosh-Roy, A., Goncharov, A., Jin, Y., Chisholm, A.D. Kinesin-13 and Tubulin 509 
Posttranslational Modifications Regulate Microtubule Growth in Axon Regeneration. 510 
Developmental Cell. 23 (4), 716–728, doi: 10.1016/j.devcel.2012.08.010 (2012). 511 
19. Chen, L. et al. Axon Regeneration Pathways Identified by Systematic Genetic 512 
Screening in C. elegans. Neuron. 71 (6), 1043–1057, doi: 10.1016/j.neuron.2011.07.009 513 
(2011). 514 
20. Tran, L.D. et al. Dynamic microtubules at the vegetal cortex predict the embryonic 515 
axis in zebrafish. Development (Cambridge). 139 (19), 3644–3652, doi: 516 
10.1242/dev.082362 (2012). 517 
21. Tirnauer, J.S., Grego, S., Salmon, E.D., Mitchison, T.J. EB1–Microtubule 518 
Interactions in Xenopus Egg Extracts: Role of EB1 in Microtubule Stabilization and 519 
Mechanisms of Targeting to Microtubules . Molecular Biology of the Cell. 13 (10), 3614–520 
3626, doi: 10.1091/mbc.e02-04-0210 (2002). 521 
22. Maniar, T.A. et al. UNC-33 (CRMP) and ankyrin organize microtubules and localize 522 
kinesin to polarize axon-dendrite sorting. Nature Neuroscience. 15 (1), 48–56, doi: 523 
10.1038/nn.2970 (2012). 524 
23. Stone, M.C., Nguyen, M.M., Tao, J., Allender, D.L., Rolls, M.M. Global Up-525 
Regulation of Microtubule Dynamics and Polarity Reversal during Regeneration of an 526 
Axon from a Dendrite. Molecular Biology of the Cell. 21 (5), 767–777, doi: 527 
10.1091/mbc.e09-11-0967 (2010). 528 
24. Puri, D., Ponniah, K., Biswas, K., Basu, A., Lundquist, E.A., Ghosh-Roy, A. WNT 529 
Signaling Establishes Microtubule Polarity in Neuron Through the Regulation of Kinesin-530 
13 Family Microtubule Depolymerizing Factor. SSRN Electronic Journal. doi: 531 
10.2139/ssrn.3456296 (2019). 532 
25. CZ18975 (strain) - WormBase : Nematode Information Resource. at 533 
<https://wormbase.org/species/c_elegans/strain/WBStrain00005443#03--10>. 534 
26. Ghosh-Roy, A., Goncharov, A., Jin, Y., Chisholm, A.D. Kinesin-13 and tubulin 535 
posttranslational modifications regulate microtubule growth in axon regeneration. 536 
Developmental Cell. 23 (4), 716–728, doi: 10.1016/j.devcel.2012.08.010 (2012). 537 
27. Chuang, M., Goncharov, A., Wang, S., Oegema, K., Jin, Y., Chisholm, A.D. The 538 
microtubule minus-end-binding protein patronin/PTRN-1 is required for axon regeneration 539 
in C. elegans. Cell Reports. 9 (3), 874–883, doi: 10.1016/j.celrep.2014.09.054 (2014). 540 
28. Stiernagle, T. Maintenance of C. elegans. WormBook. 1–11, doi: 541 
10.1895/wormbook.1.101.1 (2006). 542 
29. Pawley, J.B. Handbook of biological confocal microscopy: Third edition. Handbook 543 
of Biological Confocal Microscopy: Third Edition. doi: 10.1007/978-0-387-45524-2. 544 
Springer US. (2006). 545 
30. Chalfie, M., Thomson, J.N. Organization of neuronal microtubules in the nematode 546 
Caenorhabditis elegans. Journal of Cell Biology. 82 (1), 278–289, doi: 547 
10.1083/jcb.82.1.278 (1979). 548 
31. Murthy, K., Bhat, J.M., Koushika, S.P. In vivo imaging of retrogradely transported 549 



   

synaptic vesicle proteins in Caenorhabditis elegans neurons. Traffic. 12 (1), 89–101, doi: 550 
10.1111/j.1600-0854.2010.01127.x (2011). 551 
32. Rao, G.N., Kulkarni, S.S., Koushika, S.P., Rau, K.R. In vivo nanosecond laser 552 
axotomy: cavitation dynamics and vesicle transport. Optics Express. 16 (13), 9884, doi: 553 
10.1364/oe.16.009884 (2008). 554 
33. Chen, L. et al. Axon Regeneration Pathways Identified by Systematic Genetic 555 
Screening in C. elegans. Neuron. 71 (6), 1043–1057, doi: 10.1016/j.neuron.2011.07.009 556 
(2011). 557 
34. Ghosh-Roy, A., Chisholm, A.D. Caenorhabditis elegans: A new model organism 558 
for studies of axon regeneration. Developmental Dynamics. 239 (5), 1460–1464, doi: 559 
10.1002/dvdy.22253 (2010). 560 
35. Hilliard, M.A., Bargmann, C.I. Wnt signals and Frizzled activity orient anterior-561 
posterior axon outgrowth in C. elegans. Developmental Cell. 10 (3), 379–390, doi: 562 
10.1016/j.devcel.2006.01.013 (2006). 563 
36. Prasad, B.C., Clark, S.G. Wnt signaling establishes anteroposterior neuronal 564 
polarity and requires retromer in C. elegans. Development. 133 (9), 1757–1766, doi: 565 
10.1242/dev.02357 (2006). 566 
37. Puri, D. et al. Wnt signaling establishes the microtubule polarity in neurons through 567 
regulation of Kinesin-13. Journal of Cell Biology. 220 (9), doi: 10.1083/jcb.202005080 568 
(2021). 569 
38. Chen, C.H., Chen, Y.C., Jiang, H.C., Chen, C.K., Pan, C.L. Neuronal aging: 570 
Learning from C. elegans. Journal of Molecular Signaling. 8 (0), doi: 10.1186/1750-2187-571 
8-14 (2013). 572 
39. Toth, M.L. et al. Neurite sprouting and synapse deterioration in the aging 573 
Caenorhabditis elegans nervous system. Journal of Neuroscience. 32 (26), 8778–8790, 574 
doi: 10.1523/JNEUROSCI.1494-11.2012 (2012). 575 
40. Bourgeois, F., Ben-Yakar, A. Femtosecond laser nanoaxotomy properties and 576 
their effect on axonal recovery in C. elegans. Optics Express. 15 (14), 8521–31, doi: 577 
10.1364/oe.15.008521 (2007). 578 
41. Raabe, I., Vogel, S.K., Peychl, J., ToliĆ-NØrrelykke, I.M. Intracellular nanosurgery 579 
and cell enucleation using a picosecond laser. Journal of Microscopy. 234 (1), 1–8, doi: 580 
10.1111/j.1365-2818.2009.03142.x (2009). 581 
42. Hutson, M.S., Ma, X. Plasma and cavitation dynamics during pulsed laser 582 
microsurgery in vivo. Physical Review Letters. 99 (15), doi: 583 
10.1103/PhysRevLett.99.158104 (2007). 584 
43. Steinmeyer, J.D. et al. Construction of a femtosecond laser microsurgery system. 585 
Nature Protocols. 5 (3), 395–407, doi: 10.1038/nprot.2010.4 (2010). 586 
44. Williams, W., Nix, P., Bastiani, M. Constructing a low-budget laser axotomy system 587 
to study axon regeneration in C. elegans. Journal of Visualized Experiments. 57 (57), 588 
3331, doi: 10.3791/3331 (2011). 589 
45. Byrne, A.B., Edwards, T.J., Hammarlund, M. In vivo laser axotomy in C. elegans. 590 
Journal of Visualized Experiments. (51), 2707, doi: 10.3791/2707 (2011). 591 
46. Basu, A. et al. let-7 miRNA controls CED-7 homotypic adhesion and EFF-1–592 
mediated axonal self-fusion to restore touch sensation following injury. Proceedings of 593 
the National Academy of Sciences of the United States of America. 114 (47), E10206–594 
E10215, doi: 10.1073/pnas.1704372114 (2017). 595 



   

47. Horio, T., Murata, T., Murata, T. The role of dynamic instability in microtubule 596 
organization. Frontiers in Plant Science. 5 (OCT), doi: 10.3389/fpls.2014.00511 (2014). 597 
48. Michaels, T.C.T., Feng, S., Liang, H., Mahadevan, L. Mechanics and kinetics of 598 
dynamic instability. eLife. 9, 1–29, doi: 10.7554/eLife.54077 (2020). 599 
49. Zhang, R., Alushin, G.M., Brown, A., Nogales, E. Mechanistic origin of microtubule 600 
dynamic instability and its modulation by EB proteins. Cell. 162 (4), 849–859, doi: 601 
10.1016/j.cell.2015.07.012 (2015). 602 
50. Aher, A., Akhmanova, A. Tipping microtubule dynamics, one protofilament at a 603 
time. Current Opinion in Cell Biology. 50, 86–93, doi: 10.1016/j.ceb.2018.02.015 (2018). 604 
51. Zwetsloot, A.J., Tut, G., Straube, A. Measuring microtubule dynamics. Essays in 605 
Biochemistry. 62 (6), 725–735, doi: 10.1042/EBC20180035 (2018). 606 
52. Harterink, M. et al. Local microtubule organization promotes cargo transport in C. 607 
elegans dendrites. Journal of Cell Science. 131 (20), jcs.223107, doi: 10.1242/jcs.223107 608 
(2018). 609 
53. Yogev, S., Maeder, C.I., Cooper, R., Horowitz, M., Hendricks, A.G., Shen, K. Local 610 
inhibition of microtubule dynamics by dynein is required for neuronal cargo distribution. 611 
Nature Communications. 8, doi: 10.1038/ncomms15063 (2017). 612 
54. Liang, X. et al. Growth cone-localized microtubule organizing center establishes 613 
microtubule orientation in dendrites. eLife. 9, 1–28, doi: 10.7554/eLife.56547 (2020). 614 
55. Yan, J. et al. Kinesin-1 regulates dendrite microtubule polarity in Caenorhabditis 615 
elegans. eLife. 2013 (2), 133, doi: 10.7554/eLife.00133 (2013). 616 
56. Wang, S. et al. NOCA-1 functions with γ-tubulin and in parallel to Patronin to 617 
assemble non-centrosomal microtubule arrays in C. elegans. eLife. 4 (September), doi: 618 
10.7554/eLife.08649 (2015). 619 
57. Castigiioni, V.G., Pires, H.R., Bertolini, R.R., Riga, A., Kerver, J., Boxem, M. 620 
Epidermal par-6 and pkc-3 are essential for larval development of c. Elegans and 621 
organize non-centrosomal microtubules. eLife. 9, 1–37, doi: 10.7554/ELIFE.62067 622 
(2020). 623 
58. Taffoni, C. et al. Microtubule plus-end dynamics link wound repair to the innate 624 
immune response. eLife. 9, doi: 10.7554/eLife.45047 (2020). 625 
59. Motegi, F., Velarde, N. V., Piano, F., Sugimoto, A. Two phases of astral 626 
microtubule activity during cytokinesis in C. elegans embryos. Developmental Cell. 10 (4), 627 
509–520, doi: 10.1016/j.devcel.2006.03.001 (2006). 628 
60. Kim, E., Sun, L., Gabel, C. V., Fang-Yen, C. Long-Term Imaging of Caenorhabditis 629 
elegans Using Nanoparticle-Mediated Immobilization. PLoS ONE. 8 (1), 53419, doi: 630 
10.1371/journal.pone.0053419 (2013). 631 
61. Agarose immobilization of C. elegans. at 632 
<http://wbg.wormbook.org/2009/12/01/agarose-immobilization-of-c-elegans/>. 633 
62. Breton, S., Brown, D. Cold-induced microtubule disruption and relocalization of 634 
membrane proteins in kidney epithelial cells. Journal of the American Society of 635 
Nephrology. 9 (2), 155–166, doi: 10.1681/asn.v92155 (1998). 636 
63. Weber, K., Pollack, R., Bibring, T. Antibody against tubulin: the specific 637 
visualization of cytoplasmic microtubules in tissue culture cells. Proceedings of the 638 
National Academy of Sciences of the United States of America. 72 (2), 459–463, doi: 639 
10.1073/pnas.72.2.459 (1975). 640 
64. Weisenberg, R.C. Microtubule formation in vitro in solutions containing low calcium 641 



   

concentrations. Science. 177 (4054), 1104–1105, doi: 10.1126/science.177.4054.1104 642 
(1972). 643 
65. Tilney, L.G., Porter, K.R. Studies on the microtubules in heliozoa. II. The effect of 644 
low temperature on these structures in the formation and maintenance of the axopodia. 645 
The Journal of Cell Biology. 34 (1), 327–343, doi: 10.1083/jcb.34.1.327 (1967). 646 
66. Li, G., Moore, J.K. Microtubule dynamics at low temperature: Evidence that tubulin 647 
recycling limits assembly. Molecular Biology of the Cell. 31 (11), 1154–1166, doi: 648 
10.1091/MBC.E19-11-0634 (2020). 649 
67. Wang, X. et al. In vivo imaging of a PVD neuron in Caenorhabditis elegans. STAR 650 
Protocols. 2 (1), 100309, doi: 10.1016/j.xpro.2021.100309 (2021). 651 
68. Dirksen, P. et al. CeMbio - The Caenorhabditis elegans microbiome resource. G3: 652 
Genes, Genomes, Genetics. 10 (9), 3025–3039, doi: 10.1534/g3.120.401309 (2020). 653 
69. Portman, D.S. Profiling C. elegans gene expression with DNA microarrays. 654 
WormBook . 1–11, doi: 10.1895/wormbook.1.104.1 (2006). 655 
 656 



Revised Figure1 Click here to access/download;Figure;Dey and Ghosh-Roy
2021_Figure1_JoVE62744_revised.png

https://www.editorialmanager.com/jove/download.aspx?id=1378204&guid=b8eafc4a-0585-42af-90f3-2617cae412de&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1378204&guid=b8eafc4a-0585-42af-90f3-2617cae412de&scheme=1


Revised Figure 2 Click here to access/download;Figure;Dey and Ghosh-Roy
2021_Figure2_JoVE62744_revised.png

https://www.editorialmanager.com/jove/download.aspx?id=1378205&guid=2ca7ea18-7a47-4c3b-a40a-3a6c1e94e6b3&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1378205&guid=2ca7ea18-7a47-4c3b-a40a-3a6c1e94e6b3&scheme=1


Revised Figure 3 Click here to access/download;Figure;Dey and Ghosh-Roy
2021_Figure3_JoVE62744_revised.png

https://www.editorialmanager.com/jove/download.aspx?id=1378206&guid=be1ff306-13c0-490d-9ebd-2500140b2f10&scheme=1
https://www.editorialmanager.com/jove/download.aspx?id=1378206&guid=be1ff306-13c0-490d-9ebd-2500140b2f10&scheme=1


  

Table of Materials

Click here to access/download
Table of Materials

Dey and Ghosh-Roy 2021_Materials
list_JoVE62744_revised.xlsx

https://www.editorialmanager.com/jove/download.aspx?id=1378207&guid=6f6a6bf2-fcc4-4172-a3a8-763f184a5841&scheme=1


Dear Dr. Nguyen, 

Thank you for the suggestions on the audio of the manuscript. We have revised the audio as 

per the suggestions. We are enclosing the revised video, and the latest point by point 

response to the editorial comments. 

Thanks and regards 

Swagata Dey and Anindya Ghosh-Roy 

 

Editorial Comments: 

• Audio levels are high. Please decrease the audio level -6db or 40% and ensure audio level 

peaks average around -9dB. 

We have now reduced the audio level to -6db throughout the video for the consistency.  

 

• 01:25 - 01:26 Please remove the noise or ""Someone is saying ok"" on narration. 

We have worked on the suggestion and removed the specific audio from the segment. 

 

• 03:55 - 03:57 Please remove the noise in the background." 

In the specific segment, we isolated and removed a background click sound to improve the 

segment. 
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